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Introduction 
The TSI Engine Exhaust Particle Sizer™ (EEPS™) spectrometer is widely used to measure the sub-
micrometer size distribution of fast changing aerosols. Using a set of 22 electrometers, the EEPS 
spectrometer records particle size distributions (PSD) at a rate of 10 Hz; allowing for the 
measurement and analysis of rapidly changing aerosols. While the EEPS spectrometer can record 
PSDs at a high rate, it is limited to a size resolution of 16 channels per decade, corresponding to 32 
channels over the range of 5.6 nm to 560 nm. For slow transient or steady-state aerosols, higher 
resolution measurements can be made using the TSI Scanning Mobility Particle Sizer™ (SMPS™) 
spectrometer. While the SMPS spectrometer is broadly considered the standard in measuring sub-
micrometer aerosols; measurements with an SMPS spectrometer take at least 5 seconds to 
complete for a size distribution of a high concentration aerosol (lower concentrations require 
longer scan times for reasonable results. 
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It has been reported that discrepancies exist between PSDs measured by EEPS spectrometer and 
those measured by SMPS spectrometer [1,2,3,4,5]. Above approximately 75 nm, particles measured by 
EEPS spectrometer are shifted to smaller sizes, resulting in a narrower distribution (having a lower 
geometric standard deviation (GSD)), and the concentrations of these larger particles are lower 
than those measured using SMPS spectrometer. It has also been shown that these discrepancies are 
more severe for aerosols composed of agglomerates (such as soot from engine exhaust) than 
compact (nearly spherical) aerosols. 

To improve the agreement between EEPS spectrometer and SMPS spectrometer measurements, 
especially at larger particle sizes, TSI has developed two new matrices; one for compact aerosols 
(IM-compact) and one for soot-like agglomerate aerosols (IM-soot). 

This application note details the observed inconsistencies between EEPS spectrometer and SMPS 
spectrometer when using the existing default matrix, the underlying cause for this discrepancy, the 
development and validation of the two new matrices, and a description of how one can use the new 
matrices with the most recent release of EEPS spectrometer software. The matrix development and 
validation was performed in conjunction with Dr. Xiaoliang Wang of Desert Research Institute (DRI) 
and the University of Minnesota Center for Diesel Research (CDR) and is discussed in greater detail 
in the companion papers [6,7]. 

Background 

Fundamental Operation of EEPS Spectrometer 

Figure 1 shows a simplified schematic 
of the EEPS spectrometer measurement 
region [8]. Sample flow of 10 L/min is 
drawn into the EEPS spectrometer and 
charged by a negative unipolar charger 
to bring the charge state of the aerosol 
to a uniform polarity. The aerosol is 
then charged by a positive unipolar 
charger and enters an annular region 
between an inner rod, and an outer 
column consisting of 22 electrometers. 
The inner rod is separated into three 
sections. Each section of the inner rod 
is independently charged to a high 
positive voltage. The aerosol is 
transported down the annular region 
by 39.4 L/min of clean, recirculating 
sheath air. As the aerosol is transported 
down the column, individual particles, 
now positively charged, are repelled 
from the center column and impact the 
electrometers that make up the outer 
column, transferring their charge. The 
specific electrometer on which a 
particle impacts depends on the 
particle’s electrical mobility i.e. 
diameter and state of charge. 

 
Figure 1:  
Model 3090 EEPS Spectrometer Schematic Diagram [8] 
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The electrical currents measured by each of the 22 electrometers are corrected for the image 
current induced on upper electrometers as particles pass them, destined for lower electrometers. 
Additionally, the electrometer signals are time aligned to correct for the delay between particles 
impacting the upper electrometers and larger particles traveling down the column and impacting 
the lower electrometers. This vector of time aligned and image current corrected signals is referred 
to as the instrument record, Ij, where j is the electrometer number (j=1,2,…,22). 

The EEPS spectrometer determines the particle size distribution by solving for f, the particle size 
distribution in Equation 1 [6]. 

             
Equation 1 

Where Ij is the instrument record, Hj,i is the EEPS spectrometer instrument matrix, fi is the particle 
size distribution and uj is a vector of noise on the electrometers. i=1,2,..,17 and corresponds to the 
boundaries of each of the primary size channels (17 channels equally spaced on a log basis over the 
5.6 to 560nm size range of the EEPS spectrometer). The EEPS spectrometer instrument matrix (IM) 
is what the EEPS spectrometer uses to convert the electrometer signals to particle size 
distributions. The default EEPS spectrometer matrix, IM-default, was developed in 2004 by Dr. Aadu 
Mirme at the University of Tartu and is based upon a combination of theoretical modeling of and 
experimental characterization with prototype EEPS spectrometer units [9]. 

The same instrument geometry and data inversion algorithm is used with the TSI Fast Mobility 
Particle Sizer™ (FMPS™); however the FMPS spectrometer is limited to a sample frequency of 1Hz 
and lacks the analog outputs of the EEPS spectrometer.  

Observed EEPS Spectrometer and SMPS Spectrometer Discrepancy 

Discrepancies between EEPS spectrometer and SMPS spectrometer PSDs have been reported by 
several sources. It has been reported that for small particles (<~75 nm) the size and concentration 
of particles as measured by EEPS spectrometer is consistent with SMPS spectrometer 
measurements; however, above 75 nm, the EEPS spectrometer begins to undersize particles, 
resulting in narrower particle distributions. It has also been reported that the discrepancy in sizing 
is more severe when sampling agglomerate particles such as engine soot. 

Jeong and Evans [2], and Zimmerman et al. [10,11], examined the discrepancies between EEPS 
spectrometer and SMPS spectrometer and showed that above ~75 nm EEPS spectrometer 
measured particle diameters were roughly 60% of those measured by SMPS spectrometer, and that 
above ~75 nm, PSDs measured by EEPS spectrometer were narrower than with SMPS 
spectrometer. The discrepancy was found to be greater for agglomerates such as engine exhaust, 
than ambient aerosols. An empirical post-processing method was developed by Jeong and Evans, 
and expanded upon by Zimmerman et al. [10,11] that showed significantly improved agreement 
between EEPS spectrometer and SMPS spectrometer data. 

Similar findings were reported by Asbach et al. [1], who used diesel soot and NaCl to evaluate four 
SMPS systems in comparison to an FMPS spectrometer. The concentrations measured between the 
TSI SMPS spectrometer and FMPS spectrometer were in reasonable agreement; however, the FMPS 
spectrometer resulted in broader distributions with mode diameters that were 9 to 22% below 
those measured by the SMPS systems. Leskinen et al. [5] showed that EEPS spectrometer and SMPS 
spectrometer measurements of compact ammonium sulfate particles were consistent in 
concentration and size for smaller particles but undersized larger particles. For TiO2 agglomerates, 
the EEPS spectrometer measured particle size was much smaller than SMPS spectrometer, and that 
this discrepancy increased at larger particle sizes. Similarly, Kaminski et al. [3] determined that for 
small compact aerosols (<40 nm NaCl), sizing and concentration between FMPS spectrometer and 
SMPS spectrometer agreed well but for larger particles and agglomerates, FMPS spectrometer 
undersized particle diameter by up to 40%.  

Lee et al. [4] compared SMPS spectrometer and FMPS spectrometer measurements of ambient 
aerosols, as well as lab generated ammonium sulfate, ammonium nitrate, and ammonium chloride 
aerosols and determined that the mode diameters as measured by FMPS spectrometer were 
roughly 40% smaller than those measured by SMPS spectrometer. Furthermore, applying a linear 
correction to the data significantly improved the sizing agreement. 
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Awasthi et al. [12]examined the difference between EEPS spectrometer and SMPS spectrometer 
diameters in agglomerates compared to compact aerosols by measuring the PSD of silver 
nanoparticles before sintering (agglomerates) and after sintering (spherical particles). The 
undersizing for agglomerates was much more pronounced than the difference when measuring 
compact particles.  

Cause of EEPS Spectrometer and SMPS Spectrometer Discrepancy 

A particle’s electrical mobility depends on both the size of the particle and the number of charges on 
the particle. Therefore, to determine particle size using electrical mobility, the charge of the particle 
must be known. SMPS spectrometer and EEPS spectrometer both impart repeatable, steady, charge  
states on the aerosol prior 
to mobility selection. SMPS 
spectrometer uses a 
bipolar neutralizer, 
whereas EEPS 
spectrometer uses a 
unipolar corona charger. 
Charging in a bipolar 
charger is dominated by 
diffusion, and the steady 
state charge distribution 
was determined by Fuchs 
[13] and approximated by 
Wiedensohler [14]. Figure 2 
shows the bipolar charge 
distribution for a soft x-ray 
neutralizer, covering the 
size range of the EEPS 
spectrometer. In this size 
range, bipolar charging is 
roughly independent of 
particle morphology [15], 
and the majority of 
particles exiting a bipolar 
charger have zero or one 
charge. As particle size 
increases the fraction of 
particles carrying multiple 
charges also increases. 

 
Figure 2:  
Bipolar charge distribution over EEPS spectrometer size range calculated using 
Wiedensohler approximation [14]. 
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When using a unipolar charger, the fraction of 
particles that are charged is much higher, and the 
increase in frequency of multiple charges with 
particle size is much more rapid. Additionally, 
particle shape affects unipolar charging due to the 
influence of electrostatic forces and increased 
capacitance [12]. Oh et al. [16] showed that unipolar 
diffusion charging theory for spheres underestimates 
the charge level of agglomerates by 30%. Awasthi [12] 
also showed in Figure 3 that the mean charge per 
particle for agglomerates is 20 to 50% higher than 
for spheres, depending on particle size. 
 
Therefore, for particles of the same size as 
determined by SMPS spectrometer, on average, 
agglomerates carry more charges than spherical 
particles. As a result, when using a unipolar charger, 
agglomerates will appear smaller than spheres. This 
effect of particle morphology on charging, and 
therefore particle sizing in an EEPS spectrometer and 
SMPS spectrometer is shown by Awasthi et al [12] in 
Figure 4. 

 
Figure 3:  
Mean charge per particle for agglomerates and 
spherical particles as a function of mobility diameter 
[12]. 

 

 
Figure 4:  
Effect of sintering temperature on particle size as measured by EEPS spectrometer and SMPS 
spectrometer. As the Sintering temperature increases, the particulates become more spherical (and 
therefore less agglomerate), and the discrepancy in particle size decreases. [12]. 

TiO2 particles were measured with EEPS spectrometer and SMPS spectrometer after a sintering 
furnace at different temperatures. As the temperature of the sintering furnace increases, and the 
initially agglomerate particle becomes more spherical, and the discrepancy between the size 
measured by EEPS spectrometer and by SMPS spectrometer decreases. 
 
Therefore, to accurately size agglomerates and spheres in a device with a unipolar charger, 
morphology-specific calculations must be used. To address this issue and improve agreement 
between EEPS spectrometer and SMPS spectrometer, two new inversion matrices were developed. 
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Matrix Development 
The matrix development and validation was performed in conjunction with the help of Dr. Xiaoliang 
Wang of Desert Research Institute and is discussed in greater detail in the companion papers [6,7]. 
Whereas the original EEPS spectrometer inversion matrix IM-default was developed using a 
combination of theoretical calculations and experimental measurements; the IM-compact and IM-
soot matrices were developed by empirically calibrating the EEPS spectrometer to SMPS 
spectrometer measurements of compact, nearly spherical aerosols, and agglomerate aerosols, 
respectively. 
 
The experimental setups for the development of both matrices were similar; a polydisperse aerosol 
was generated and then classified using one or two differential mobility analyzers (DMA) to 
generate a monodisperse aerosol. The monodisperse aerosol was then delivered to an SMPS 
spectrometer, EEPS spectrometer, and condensation particle counter (CPC) as shown in Figure 5. 
The EEPS spectrometer, SMPS spectrometer, and CPC sampled simultaneously and the size 
distributions measured by the SMPS spectrometer, the total concentration measured by SMPS 
spectrometer and CPC, and the instrument record measured by the EEPS spectrometer were used to 
generate the EEPS spectrometer inversion matrix, Hj,j using Equation 2 [6]. 

                  
Equation 2 

Where Hj,i is the instrument matrix, Ij is the instrument record measured by the EEPS spectrometer, 
N is the total number concentration measured by SMPS spectrometer and CPC, and Dpi is the mode 
particle diameter of the monodisperse aerosol as measured by the SMPS spectrometer. 
 

a. b. 

 
 

Figure 5:  
a. Equipment configuration for the development of IM-compact [6] b. Equipment configuration for the development of IM-
soot [7]. The sample line lengths from the mixing chamber/manifold to the instruments were proportional to the sample 
flow rates of each instrument to ensure consistent diffusion losses across all instruments. 
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IM-Compact 

Monodisperse compact aerosols were generated at each of the EEPS spectrometer 17 primary 
channel diameters (i) by classifying a polydisperse aerosols using a TSI model 3082 electrostatic 
classifier. The polydisperse aerosols were generated using two aerosol generators. 
 
For particles smaller than 30 nm an electrospray aerosol generator (EAG, TSI model 3480) was 
used to generate solid sucrose and liquid poly-alpha-olefin (PAO) oil particles. For particles 
between 30 and 560 nm, a Collison-type atomizer (TSI model 3076) was used to generate solid NaCl 
and liquid PAO particles. 
 
To reduce the number of multiply-charged particles being delivered to the instruments, the 
classified sizes were always chosen to be larger than the mode of the polydisperse distribution. 
Additionally, when the initial aerosol concentration was high enough, two classifiers were used in 
series to limit the multiply-charged fraction. For the largest sizes, a single classifier and impactors 
were used to remove larger, multiply-charged particles.  
 
The resulting monidisperse distributions were measured using EEPS spectrometer, a 3775 CPC, and 
a 3938 SMPS spectrometer consisting of a model 3082 classifier and a 3776 CPC. For sizes below 
40 nm model 3085 nano-DMAs were used; for sizes above 40 nm model 3081 long DMAs were used.  
 
For the sizes in which the multiply-charged particles persisted, the instrument matrix column was 
corrected for the contribution of doubly-charged particles by determining the fraction of doubly 
charged particles in the sample using SMPS spectrometer data, and determining the instrument 
kernel function of the doubly charged particle size by interpolating the kernel functions of the two 
neighboring columns. The fraction of the multiply charged particles was then multiplied by the 
interpolated kernel function to determine the contribution to the uncorrected instrument matrix 
column. The corrected matrix column was then determined by subtracting this contribution from 
uncorrected instrument matrix column. This procedure is examined in detail in [6].  
 
The resulting instrument matrix is plotted in Figure 6 where each curve corresponds to a column of 
the instrument matrix, Hj,i from Equation 2.  

 
Figure 6:  
EEPS spectrometer "compact" inversion matrix (IM-compact) resulting from calibrating EEPS 
spectrometer to SMPS spectrometer measurements of compact aerosols. Each curve corresponds to 
a column of the instrument matrix. [6]. 
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IM-Soot 

As in the development of IM-compact, IM-soot was developed by calibrating the EEPS spectrometer 
to SMPS spectrometer measurements using monodisperse aerosols classified from a polydisperse 
aerosol. However, the initial polydisperse aerosol used for IM-soot was diluted diesel engine 
exhaust. Calibration was performed in conjunction with the University of Minnesota CDR using a 
John Deere 4045H (turbocharged, 4 cylinder, 4.5L, 75 kW, Tier 3) diesel engine fueled with BP6 
diesel fuel with a sulfur content of 6 ppm.  

As shown in Figure 5, the exhaust was sampled and diluted with cooled filtered air using an ejector 
diluter at a dilution ratio of approximately 4:1. The diluted exhaust was aged for approximately 1 
second in a dilution tunnel before being classified by a TSI model 3080 electrostatic classifier. The 
monodisperse aerosol was then mixed with filtered air in a manifold before being simultaneously 
sampled by two EEPS spectrometer (one belonging to TSI and one to the University of Minnesota) 
as well as a 3775 CPC and 3936 SMPS spectrometer consisting of a 3080 classifier and a 3776 CPC. 
For sizes below 40 nm model 3085 nano-DMAs were used; for sizes above 40 nm model 3081 long 
DMAs were used. The engine was operated at a variety of speeds and loads to generate particle 
distributions across the full operating range of the engine and the full size range of the EEPS 
spectrometer. 
 
Additionally, the exhaust sample was secondarily diluted at a ratio of approximately 12:1 and the 
resulting polydisperse distributions were sampled with the suite of instruments to evaluate the 
matrix performance.  
 
To reduce the multiply-charged particles passing through the classifier, monodisperse sizes were 
consistently chosen to be larger than the mode particle diameter of the polydisperse distribution. 
Additionally, the contribution of multiply charged particles was subtracted from the resulting 
matrix as described in the above IM-Compact section and further detailed in [6]. 
 
The polydisperse distributions were controlled by the engine operating condition, and the 
monodisperse classified sizes were chosen to be just larger than the mode particle diameter; as a 
result, the sizes in the resulting matrix columns did not necessarily correspond with EEPS 
spectrometer primary channel boundary diameters (i=1,2,…,17 from Equation 1) as required by the 
EEPS spectrometer instrument matrix. 
 
To develop instrument matrix columns at each of the primary channel boundary diameters, the 
following process was used and is further detailed in [7]. Lognormal fits [17] were applied to each of 
the measured matrix columns. The controlling parameters for each lognormal fit were plotted and 
best fit functions fit to the plotted parameters. These best fit functions were used to determine 
lognormal fit parameters at the EEPS spectrometer primary channel boundary diameters. These fit 
parameters were then used to develop an instrument matrix at the corresponding EEPS 
spectrometer primary channel boundary diameters. The resulting IM-soot matrix is plotted in 
Figure 7 where each curve corresponds to a column of the instrument matrix, Hj,i from Equation 2. 
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Figure 7:  
EEPS spectrometer soot inversion matrix (IM-soot) resulting from calibrating EEPS spectrometer to 
SMPS spectrometer measurements of agglomerate aerosols, specifically diesel engine exhaust. Each 
curve corresponds to a column of the instrument matrix. [7]. 

Comparison of EEPS Spectrometer Inversion Matrices 

In Figure 6 and Figure 7 each curve represents a column of the instrument matrix i.e. the 
concentration normalized electrometer signal recorded for each of the monodisperse aerosols 
listed. As the mean particle size increases, the electrometer number on which the particles are 
detected also increases. Additionally, since the particle charge distribution broadens as size 
increases, the larger particles are detected on a wider range of electrometers, broadening the 
instrument matrix columns for larger sizes. It should also be noted that the IM curves are often 
overlapping, indicating that a single electrometer can detect particles of multiple sizes. This 
overlapping limits the EEPS spectrometer sizing resolution of the EEPS spectrometer to 16 channels 
per decade. Additionally, the y-axes of Figure 6 and Figure 7 are plotted on log scales to show the 
wide range of signal strengths on each electrometer for each size. 
 
Figure 8 shows the 42 nm and 420 nm instrument matrix columns for the three matrices, IM-
default, IM-compact, and IM-soot. Since with a unipolar charger, agglomerates obtain a higher state 
of charge than spherical particles, the agglomerates have a higher electrical mobility than their 
compact counterparts of equivalent size. Thus, the 420 nm column in IM-soot corresponds to a 
lower number electrometer than the 420 nm column in IM-compact or IM-default. Additionally, it 
can be seen that for the smaller 42 nm columns, since the agglomerates are more compact at this 
size, the difference between matrices is much less. The differences in the plotted columns for 
different aerosols are consistent with the discrepancies reported by others in the Background 
section, as agglomerates would show up as smaller particles using IM-default. 
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Figure 8:  
Comparison of 420 nm and 42 nm EEPS spectrometer inversion matrix columns for IM-default, IM-
compact, and IM-soot matrices  

Results Using New Matrices 
The IM-compact and IM-soot matrices were evaluated by comparing SMPS spectrometer 
measurements to EEPS spectrometer measurements processed with the compact and soot matrices 
for compact aerosols and engine exhaust, respectively. Multiple EEPS units were tested on a variety 
of aerosol types to determine the bulk effect of the alternative matrices. 

Compact Inversion Matrix Results 

A comparison of the EEPS spectrometer compact and default matrices measuring a variety of 
compact aerosols are presented in Figure 9. As shown in a, c, and e, the use of the EEPS 
spectrometer compact matrix results in much better agreement with the SMPS spectrometer size 
distributions. As the mode particle diameter increases, from 40 nm in a, to 160 nm in c, and 280 nm 
in e, the undersizing of the default matrix becomes apparent. However, if the compact matrix is 
used, the resulting EEPS spectrometer distributions much more closely match the SMPS 
spectrometer distribution in both sizing and concentration. 
 
In addition to the undersizing issue shown with the default matrix, the entire distribution as 
measured by EEPS spectrometer is on average much narrower than the distribution as measured by 
SMPS spectrometer. As a result, when the data are plotted on a volume weighted scale, the default 
matrix greatly underestimates particle volume. When using the compact matrix, the discrepancy in 
volume is significantly reduced. Further details can be found in [6]. 
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a. b. 

 
c. d. 

 
e. f. 

 
Figure 9:  
EEPS spectrometer Default and compact instrument matrix number and volume weighted particle size distribution 
compared to SMPS spectrometer for atomized NaCl (a, b) and atomized PAO (c,d,e,f) of various sizes. 
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Soot Inversion Matrix Results 

Data were collected by EEPS spectrometer and SMPS spectrometer on multiple engine types 
running at several different conditions and compared to evaluate the performance of the EEPS 
spectrometer soot matrix. Figure 10 shows example measurements taken from a John Deere 4045h 
heavy duty engine running at two loads [7]. 

a. b. 

 
c. d. 

 
Figure 10:  
EEPS spectrometer Default and soot instrument matrix processed number and volume weighted particle size distribution 
compared to SMPS spectrometer for a heavy duty diesel engine running at 1400 RPM, 50 Nm (a, b) and 1400 rpm, 450 Nm 
(c, d) [7]. 

For both the low load (a) and high load (b) engine conditions, the EEPS spectrometer data 
processed with the soot matrix more closely match SMPS spectrometer data than EEPS 
spectrometer data processed using the default matrix. Additionally because the sizing of particles 
larger than 75 nm is drastically improved, when weighted for volume, the EEPS spectrometer soot 
matrix again agrees with SMPS spectrometer much more closely. Further details can be found in [7]. 

Figure 11 shows example results from tests completed in conjunction with the University of 
Minnesota CDR on a GM A20DTH 2.0L light duty turbo charged diesel engine. The dilution and 
sampling system was similar to the one described in Figure 5b. When plotted on a number weighted 
scale, the mode diameter (as measured by SMPS spectrometer) is 18 nm. While the mode diameter 
of the EEPS spectrometer default matrix and EEPS spectrometer soot matrix are both within 5% 
(19 nm, and 17 nm respectively), the concentration of the default matrix is much lower than that of 
the SMPS spectrometer, while still reporting a lower concentration than the SMPS spectrometer, the 
soot matrix results in a distribution that more closely matches that of SMPS spectrometer. The same 
is true when plotted on a volume distribution. 
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a. b. 

 

Figure 11: 
EEPS spectrometer Default and soot instrument matrix processed number (a) and volume (b) weighted particle size 
distribution compared to SMPS spectrometer for a light-duty diesel engine running at 1500 rpm and 4 bar BMEP. 

Data were also collected from a Mazda 3 on a chassis dynamometer and are shown in Figure 12. As 
with the heavy duty and light duty diesel engines, the soot matrix more closely matches SMPS 
spectrometer measurements when number weighted as well as when volume weighted. 

a. b. 

 
Figure 12:  
EEPS spectrometer Default and soot instrument matrix processed number (a) and volume (b) weighted particle size 
distributions compared to SMPS spectrometer for a passenger car running at 60 mph and 2% load [7]. 

As a result of improved sizing performance, the agreement between SMPS spectrometer measured 
volume distributions and EEPS spectrometer measured volume distributions is significantly 
improved. Together with an assumption of soot density, the use of the soot inversion matrix 
significantly improves the ability of EEPS spectrometer to measure soot mass.  

Solid particle data were collected from the GM A20DTH at the University of Minnesota CDR a two 
stage partial flow dilution system and catalytic stripper. When compared over the same size range 
(i.e. greater than 23 nm) EEPS data processed with the soot inversion matrix agreed with TSI model 
3790A engine exhaust CPC concentrations to within approximately ±10%. 
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Overall Sizing Comparison 

a. b. 

  

Figure 13:   
Mean diameter of number weighted particle size distributions as measured by EEPS spectrometer compared to those as 
measured by SMPS spectrometer for compact aerosols (a) and engine exhaust (b) processed with the default matrix 
(represented as IM-2004) and the compact matrix (a) and soot matrix (b) [6,7]. 

To examine the bulk sizing performance of the soot and compact EEPS spectrometer matrices, the 
mean diameter of several compact aerosols as measured by EEPS spectrometer (compact and 
default) were plotted against the mean diameter as measured by SMPS spectrometer in Figure 13a. 
Using the default matrix, the mean diameter as measured by EEPS spectrometer is roughly 60% of 
that as measured by SMPS spectrometer. When the compact matrix is applied, the data follow a 1:1 
trend across the entire size range. Likewise, for several different engine models and operating 
conditions, the geometric mean diameters as measured by EEPS spectrometer using the soot matrix 
follow a 1:1 trend with the geometric mean diameters as measured by SMPS spectrometer as shown 
in Figure 13b. However, when the default matrix is used, the EEPS spectrometer geometric mean 
diameters are up to 50% smaller than those measured by SMPS spectrometer. 

Software and Firmware Updates 
TSI has released MCU firmware version 3.13 and software version 3.2.5. Firmware version 3.13 allows 
an inversion matrix other than the default to be uploaded onto the EEPS instruments itself, displaying 
data on the front panel processed with the uploaded matrix.  

With EEPS spectrometer software version 3.2.5, data can be collected using IM-default, IM-compact, 
IM-soot, or any custom matrix. Additionally, software version 3.2.5 can be used to post-process 
previously recorded EEPS spectrometer data files provided that the files contain the raw instrument 
record. The raw instrument record is saved in any EEPS spectrometer data file recorded with 
software version 3.1.0 or later and MCU firmware version 3.05 or later. Data files collected on 
instruments with an MCU firmware version older than 3.05 and or software version older than 3.1.0 
do not contain the raw instrument record and thus cannot be post processed using the EEPS 
spectrometer software. 

The EEPS spectrometer MCU firmware version is displayed on the EEPS spectrometer front panel 
screen in the moments after turning on the EEPS spectrometer. The EEPS spectrometer software 
version can be found by opening the EEPS spectrometer software and navigating to Help>About EEPS 
spectrometer Software. A simple way to tell if a file contains the raw instrument record is to open the 
file using EEPS spectrometer software and navigate to the Export Data Options window by clicking 
File>Export… If "Raw Data (Instrument Record)" is displayed as an option in the "Data Types" 
section, as shown in Figure 14a, the file contains the raw instrument record and can be post-
processed with an alternative inversion matrix in software version 3.2.5. If the option is missing as in 
Figure 14b., the raw instrument record was not recorded with the file and the data cannot be post-
processed using an alternative matrix. 
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a. b. 

  
Figure 14:  
Export data screen for an EEPS spectrometer data file containing the raw instrument record (a.) and an EEPS 
spectrometer data file without the raw instrument record (b.). 

Software version 3.2.5 and firmware version 3.13 are available as free upgrades. Contact TSI 
support at particle@tsi.com, with the serial number and firmware version of the instrument to be 
upgraded. To upgrade to firmware version 3.13, the existing EEPS spectrometer firmware version 
must be version 3.0 or greater. EEPS instruments with an MCU firmware version older than 3.0 
cannot be upgraded to version 3.13 without being sent back to TSI for service due to hardware 
changes. Contact your TSI sales representative for information on upgrading a unit with firmware 
older than 3.0. 

Using an Alternative Matrix in EEPS Spectrometer Software Version 3.2.5 

Information on using an alternative EEPS spectrometer matrix can be found in the EEPS 
spectrometer instruction manual located in the EEPS spectrometer software installation directory. 
Briefly, to reprocess data from an existing file, open the data file and navigate to the properties 
window by clicking File>Properties. In the “Instrument Matrix” section choose from “DEFAULT”, 
“COMPACT”, “SOOT”, or a custom matrix from the drop down menu to select one of the alternate 
matrices. Click Apply to reprocess the data file. The file can then be saved under a different file 
name or can be saved over the existing file. 

Which Inversion Matrix Should I use? 
EEPS spectrometer Software version 3.2.5 allows the user to collect, and process data using any of 
the three included matrices (default, compact, soot) in addition to any custom matrices that may be 
created. In general, the soot matrix should be used for engine exhaust and the compact matrix 
reserved for studies in which it is known that the aerosol being sampled is near-spherical in nature.  
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